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 Summary 

This paper provides the status for the GOLD – Performance Analysis Tool (G-
PAT).  The purpose of the G-PAT is to provide air navigation service providers 
(ANSPs) with a software tool to aid in the creation of the GOLD performance 
charts.  This paper also provides the draft user manual for G-PAT. 

 

1 INTRODUCTION 

1.1 This paper provides the current status of the GOLD – Performance Analysis Tool (G-
PAT).  G-PAT is software which can be used to create GOLD performance charts from 
input Computer Pilot Data Link Communications (CPDLC) and Automatic Dependent 
Surveillance - Contract (ADS-C) data.  The G-PAT has a graphical user interface (GUI) 
which can be run on a MS Windows-based personal computer.  

1.2 G-PAT will import pre-filtered data in the GOLD format1, create the requisite cumulative 
distributions and generate the reports and charts selected by the user.  Currently, G-PAT 
is in beta test with a few selected users.  The FAA is awaiting responses from these users 
and will eventually make G-PAT available to all ANSPs.  

                                                 
1 There is one additional field needed by G-PAT – see Table 1 in this paper  
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1.3 This paper contains a description of the important requirements related to the input data 
for use by the G-PAT.  In addition, this paper contains the current version of the G-PAT 
draft user manual and samples of input data files. 

2 DISCUSSION 

2.1 The prescribed data for the CPDLC and ADS-C data found in Appendix D of the GOLD 
are needed to successfully run the software.  The input file must contain data of only one 
type; CPDLC or ADS-C.  A file containing the CPDLC data and another file containing 
the ADS-C data are needed to create the Required Communication Performance (RCP) 
and Required Surveillance Performance (RSP) charts.  G-PAT automatically determines 
the transaction type from the input data. 

2.2 The current draft version of the G-PAT user manual is attached as Appendix A to this 
paper.  Detailed instructions with screen shots are provided.   

2.3 The input data must be in comma separated format.  There are a few notes related to the 
input files which are important.   

2.3.1 The current version of the software requires a header row in each input file.  For the 
CPDLC transaction data, this header row should appear as follows: 

ATSP,REGNO,ACTYPE,OPER,DATE,MASRGS,OPRGS,UTIME,MASTIME,MASRT
RP,FMSTIME,ATSPTIME,OPRTRIP,DTIME,UMSG,DMSG,ACTP,ACP,PORT,COM
TYP 

Although the above text wraps, it is to be the first row in the CPDLC input data files.  A 
small sample of input CPDLC transaction data is shown in Appendix B.   

The header row for ADS-C transaction data should appear as follows: 

ATSP,REGNO,ACTYPE,OPER,DATE,RGS,TYP,LAT,LONG,STIME,RTIME,DEL,C
OMTYP 

A small sample of input ADS-C transaction data is shown in Appendix B. 

2.3.2 Some of the initial comments on the current version of the software indicate that the 
addition of this row is troublesome.  This header row is used by the software to identify 
the type of input data.  The software developers are looking into other methods to 
recognize the type of input data and detect any input errors.   

2.3.3 The second item that is needed in the input data is an additional field which specifies the 
media used to transmit the message.  This information is needed to observe data by 
media; for example, it might be necessary to observe performance for HF data link 
messages only.  The additional field is the last field in both input files; COMTYP.  Table 
1 contains the possible values for COMTYP for the CPDLC transaction data.   
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2.3.4 There are nine possible entries for the COMTYP field for the CPDLC transaction data.  
The left column of Table 1 specifies the media used in the uplink CPDLC message.  The 
middle column in Table 1 specifies the media used in the downlink CPDLC response 
message.  The resulting value for COMTYP is contained in the last column of Table 1.  
For example, if both the uplink CPDLC transaction and downlink CPDLC response were 
sent using satellite (SAT) data link, the value for COMTYP is SAT.  If the uplink 
CPDLC transaction was sent via SAT and the downlink CPDLC response was sent via 
VHF, the resulting value of COMTYP is SV. 

 

Table 1.  Input Data - COMTYP field 

MAS RGS Communication Type OPS RGS Communication 
Type 

COMTYP 

SAT  e.g. MAS RGS = POR1 SAT  e.g. OPS RGS = POR1 SAT 
VHF e.g. MAS RGS = ADK VHF  e.g. OPS RGS = ADK VHF 
HF e.g. MAS RGS = H02 HF e.g. OPS RGS = H02 HF 
SAT  e.g. MAS RGS = POR1 VHF  e.g. OPS RGS = ADK SV 
SAT  e.g. MAS RGS = POR1 HF e.g. OPS RGS = H02 SH 
VHF e.g. MAS RGS = ADK SAT  e.g. OPS RGS = POR1 VS 
VHF e.g. MAS RGS = ADK HF e.g. OPS RGS = H02 VH 
HF e.g. MAS RGS = H02 VHF  e.g. OPS RGS = ADK HV 
HF e.g. MAS RGS = H02 SAT  e.g. OPS RGS = POR1 HS 

 

2.3.5 For the ADS-C transaction data, there are three possible entries for the COMTYP field.  
The ADS-C transaction was either sent via SAT, VHF, or HF. 

2.3.6 Some of the initial comments received on the current version indicate that the addition of 
the COMTYP field does not need to be part of the G-PAT format.  The GOLD Ad-Hoc 
Working Group is proposing to target a 2nd Edition of the GOLD by the first quarter of 
2013, this field is currently being considered for an addition to the GOLD required 
format.  It would be difficult for the software to determine the COMTYP for every 
transaction, as some of the station identifiers are known only locally to each ANSP (for 
example, VHF and HF stations).   

2.4 In the current version of the software, t is necessary to have both the header row and valid 
entries in the COMTYP field for the G-PAT software to run successfully.   
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3 ACTION BY THE MEETING 

3.1 The Meeting is invited to:  

a) Note the information provided in this paper; and 

b) Provide comments to the United States on the expected use of the G-PAT software. 
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Attachment A. G-PAT User Manual 
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1. Introduction 

1.1. The GOLD Performance Analysis Tool (G-PAT) is used to monitor performance of the 
operational data link system in a given airspace, by analyzing operational data and comparing the 
results to the specifications outlined in the Global Operational Data Link Document (GOLD). 

1.2. The G-PAT creates GOLD-format performance charts for both the CPDLC and ADS-C 
messages.  The performance for CPDLC messages are measured against the Required 
Communication Performance (RCP).  The message transit times for ADS-C reports are measured 
against the Required Surveillance Performance (RSP).  Both the RCP and RSP criteria as 
described in the GOLD. 

1.3. The G-PAT creates GOLD-format charts and reports with up to 2 levels of filtering, i.e. 
for a specific aircraft type used by a specific operator. For example, to monitor the fleet of B744 
used by Operator ABC, the user would apply a first level filter by selecting Operator ABC from 
the list of Operators available in the data, then apply a second level filter by selecting Aircraft 
Type B744 from the list of Aircraft Types available in the data for Operator ABC. 

1.4. This manual provides the format required for the CPDLC and ADS-C input files and 
details how to use the Tool. Screen shots of the various steps are included along with sample 
output. GOLD charts and reports are created by the G-PAT by following these steps.   

 Loading data into the Tool 
 First Level Filtering 
 Second Level Filtering 
 Selection of Performance Parameter and Criteria 
 Generation of the Output Chart and Report 
 Modification of the Chart 
 Save or Print a Copy of the Chart or Report 

2. Input Files 

2.1. The input files containing the CPDLC and ADS-C operational data should be in the 
comma separated values (CSV) format specified in the GOLD. The files should contain all of the 
fields prescribed in the GOLD as well as an additional field appended to the end of each line 
specifying the media type.   

2.2. It is essential to include a header row in each input file.  The G-PAT uses this header row 
to distinguish between ADS-C and CPDLC input data.  The header row also provides the user 
with an extra means to verify that the fields are in the expected order.   

2.3. Table 1 describes the 20 fields required for the input data files containing the CPDLC 
data link messages.  The first 19 fields contained in Table 1 are from the GOLD, Appendix D, 
Table D-1.  The last row in Table 1, is the media type used for the CPDLC transaction, and is 
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necessary to distinguish performance amongst the satellite (SAT), VHF and HF data link 
messages. 

2.4. Field 20, which contains the data link communication type, will have one of the nine 
values listed in column 3 of Table 2.  This information is based on the communication types 
associated with both the indicated MAS RGS and OPS RGS data fields.   

2.5. The header row required for the CPDLC input data is: 

ATSP,REGNO,ACTYPE,OPER,DATE,MASRGS,OPRGS,UTIME,MASTIME,MASRTRP,FM
STIME,ATSPTIME,OPRTRIP,DTIME,UMSG,DMSG,ACTP,ACP,PORT,COMTYP 

Table 1.  Required CPDLC Input Data  

Ref Label GOLD Field 
Name 

Description and/or remarks 

1 ATSP ATSP The four letter ICAO designator of the FIR, e.g. NZZO. 
2 REGNO Aircraft 

registration  
The aircraft registration in ICAO Doc 4444 Format (no 
hyphens, packing dots, etc.), e.g. N104UA. 
Note.— Extracted from ACARS header or application 
message. 

3 ACTYPE Aircraft type 
designator 

The ICAO aircraft type designator, e.g. B744. 
Note.— Extracted from ATSP database using aircraft 
registration as key. 

4 OPER Operator 
designator 

The ICAO designator for the aircraft operating agency, e.g. 
UAL. 
Note.— Extracted from ATSP database using aircraft 
registration as key. 

5 DATE Date  In YYYYMMDD format, e.g. 20081114. 
Note.— Extracted from ATSP system data recording 
time stamp, synchronized to within 1 second of 
Universal Time Coordinated (UTC). 

6 MASRGS MAS RGS Designator of the RGS that MAS downlink was received 
from, e.g. POR1. 
Note.— This is a 3 or 4 letter designator extracted from 
the ACARS header DT line. 

7 OPRGS OPS RGS Designator of the RGS that the operational response was 
received from, e.g. AKL1. 
Note.— This is a 3 or 4 letter designator extracted from 
the ACARS header DT line. 

8 UTIME Uplink time The timestamp on the uplink CPDLC message sent by the 
ATSP in HH:MM:SS format, e.g. 03:43:25. 
Note.— Extracted from ATSP system data recording 
time stamp, synchronized to within 1 second of UTC. 
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Ref Label GOLD Field 
Name 

Description and/or remarks 

9 MASTIME MAS receipt time The ATSP timestamp on receipt of the MAS in HH:MM:SS 
format, e.g. 03:43:55. 
Note.— Extracted from ATSP system data recording 
time stamp, synchronized to within 1 second of UTC. 

10 MASRTRP MAS round trip 
time 

In seconds (#9-#8), e.g. 10. 

11 FMSTIME Aircraft FMS time 
stamp 

In the operational response messages in HH:MM:SS, e.g. 
03:44:15. 
Note.— Extracted from the ATCmessageHeader 
timestamp in the decoded operational response 
message. See RTCA DO-258AEUROCAE ED-100A 
section 4.6.3.3. 

12 ATSPTIME ATSP timestamp 
on the receipt of 
the operational 
response  

In HH:MM:SS, e.g. 03:44:45. 
Note.— Extracted from ATSP system data recording 
time stamp, synchronized to within 1 second of UTC. 

13 OPRTRIP Operational 
message round 
trip time 

From sending uplink (#8) to receipt of operational response 
(#12) in seconds, e.g. 80. 

14 DTIME Downlink 
response transit 
time  

In seconds (#12-#11), e.g. 30. 

15 UMSG Uplink message 
elements 

All uplink message element identifier preceded by U 
encapsulated between quotation marks with a space 
between each element, e.g. “U118 U80” 
Note.— Extracted from the decoded operational uplink 
that initiated the transaction. 

16 DMSG Downlink 
message 
elements 

All downlink message elements encapsulated between 
quotation marks with a space between each element if 
required, e.g. “D0” 
Note.— Extracted from the decoded operational 
downlink. 

17 ACTP ACTP Actual communication technical performance in seconds, 
e.g. 35. 
Note.— Truncated to whole seconds. 

18 ACP ACP Actual communications performance in seconds measured 
as the difference between time uplink sent (#8) to 
operational response received (#12), e.g. 80. 

19 PORT PORT Pilot Operational Response Time = ACP (#18) – 
ACTP(#17), e.g. 45. 
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Ref Label GOLD Field 
Name 

Description and/or remarks 

20 COMTYP COMTYP Data link communication type, e.g. SAT 
Note: There are nine possible entries for COMTYP are SAT, 
VHF, HF, SV, SH, VS, VH, HS, HV.  Value is based on the 
MAS RGS field (#6) and OPS RGS (#7).  See Table 2.  
Satellite (SAT), Very High Frequency (VHF), High 
Frequency (HF) 

 
 
 
 
 
 
 

Table 2.  Possible Values for the Data Link Communication Type in the CPDLC Data 

MAS RGS Communication 
Type 

OPS RGS Communication 
Type 

COMTYP 

SAT  e.g. MAS RGS = POR1 SAT  e.g. OPS RGS = POR1 SAT 

VHF e.g. MAS RGS = ADK VHF  e.g. OPS RGS = ADK VHF 

HF e.g. MAS RGS = H02 HF e.g. OPS RGS = H02 HF 

SAT  e.g. MAS RGS = POR1 VHF  e.g. OPS RGS = ADK SV 

SAT  e.g. MAS RGS = POR1 HF e.g. OPS RGS = H02 SH 

VHF e.g. MAS RGS = ADK SAT  e.g. OPS RGS = POR1 VS 

VHF e.g. MAS RGS = ADK HF e.g. OPS RGS = H02 VH 

HF e.g. MAS RGS = H02 VHF  e.g. OPS RGS = ADK HV 

HF e.g. MAS RGS = H02 SAT  e.g. OPS RGS = POR1 HS 

 

2.6. Table 3 describes the 13 data fields required for the ADS-C input file.  The first 12 fields 
contained in Table 1 are taken from the GOLD, Appendix D, Table D-2.  The last row in Table 
3, field 13, is the media type, and is necessary to distinguish performance amongst the satellite 
(SAT), VHF and HF data link messages. 

Table 3.  Required ADS-C Input Data   
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Ref Label GOLD Field 
Name 

Description and/or remarks 

1 ATSP ATSP The four letter ICAO designator for the FIR of the reporting 
ATSP, e.g. NZZO. 

2 REGNO Aircraft 
Registration 

The aircraft registration in ICAO Doc 4444 Format (no 
hyphens, packing dots, etc.), e.g. N104UA. 
Note.—  Extracted from ACARS header or application 
message. 

3 ACTYPE Aircraft Type 
Designator 

The ICAO aircraft type designator, e.g. B744. 
Note.—  Extracted from ATSP database using aircraft 
registration as key. 

4 OPER Operator 
Designator 

The IATA designator for the aircraft operating agency, e.g. 
UAL. 
Note.—  Extracted from ATSP database using aircraft 
registration as key. 

5 DATE Date In YYYYMMDD format, e.g. 20081114. 
Note.—  Extracted from ATSP system data recording time 
stamp, synchronized to within 1 second of UTC. 

6 RGS RGS Designator of the RGS that ADS-C downlink was received 
from, e.g. POR1. 
Note.—  This is a 3 or 4 letter designator extracted from 
the ACARS header DT line. 

7 TYP Report Type The type of ADS-C report extracted from the ADS-C basic 
group report tag where tag value 7=PER, 9=EMG, 10=LDE, 
18=VRE, 19=ARE, 20=WCE. As some aircraft concatenate 
more than one report in the same downlink extract the ADS-C 
report tag from each ADS-C basic group and identify them in 
the REP_TYPE column by using the first letter of the report 
type as an identifier e.g. for a concatenated report containing 
two ADS-C basic groups for a periodic report and a waypoint 
event report the field will contain PW. Where a downlink does 
not contain a ADS-C basic group the REP_TYPE field will be 
left blank. 

8 LAT Latitude The current latitude decoded from the ADS-C basic group.  The 
format is “+” for North or “-“ for South followed by a decimal 
number of degrees, e.g. -33.456732. 

9 LONG Longitude The current longitude decoded from the ADS-C basic group. 
The format is “+” for East or “-“ for West followed by a decimal 
number of degrees, e.g. +173.276554. 

10 STIME Aircraft Time The time the ADS-C message was sent from the aircraft in 
HH:MM:SS, e.g. 03:44:15. 
Note.—  Decoded from the ADS-C basic group timestamp 
extracted as seconds since the most recent hour.  See 
RTCA DO-258A/EUROCAE ED-100A, section 4.5.1.4. 
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Ref Label GOLD Field 
Name 

Description and/or remarks 

11 RTIME Received Time The ATSP timestamp on the receipt of the ADS-C message in 
HH:MM:SS, e.g. 03:44:45. 
Note.—  Extracted from ATSP system data recording time 
stamp, synchronized to within 1 second of UTC. 

12 DEL Transit Time The transit time of the ADS-C downlink in seconds calculated 
as the difference between #10 Aircraft Time and #11 Received 
Time, e.g. 30. 

13 COMTYP COMTYP Data link communication type, e.g. SAT 
Note: There are three possible entries for COMTYP are SAT, 
VHF, or HF.  Value is based on the RGS field (#6).  Satellite 
(SAT), Very High Frequency (VHF), High Frequency (HF) 

 
 

2.7. The header row required for the ADS-C input data is: 

ATSP,REGNO,ACTYPE,OPER,DATE,RGS,TYP,LAT,LONG,STIME,RTIME,DEL,COMTYP 

 

 

3. Loading Data into the Tool 

3.1. The first step in using the Tool is to load the CPDLC or ADS-C input data. This is 
accomplished by selecting “Open” from the File Pull-down Menu of the Toolbar.  Alternately, 
the user can click the “Open” button below the Toolbar as illustrated in Figure 1. From here, the 
user selects the data of interest to be loaded into the Tool.  The input data must be in a comma 
separated format following the data field structure described in Table 1 for CPDLC data or Table 
3 for ADS-C data. It is important that the first row of the input file contain the necessary header 
row (see section 2 for details). 

3.2. Once the data has been loaded, the G-PAT automatically generates a generic GOLD chart 
for the unfiltered data.  The header row is used to determine the input data, ADS-C or CPDLC.   
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Figure 1 

4. First-Level Filtering 

4.1. The first level filtering option is accessed by selecting the “Filters” option on the Toolbar.  
The following types of first-level filters are available: 

 FIR - Flight Information Region 
 Media Type – Satellite (SAT), VHF, HF , etc… 
 GES - Ground Earth Stations 
 Operator 

 Aircraft Type 

4.2. In the “Filters” pull-down Menu, the number of options within the selected data set that 
are associated with each filter type is shown next to the name of the filter type. The example 
shown in Figure 2 lists only one option for FIR, eight options for Media Type, and so on.  The 
number of available options will vary depending on the data loaded into the program. 

4.3. Once a filter is selected from the “Filters” pull-down Menu, a new window is presented 
that contains further information about the selected filter.  Figure 3 shows a sample of a pop-up 
window for Filter by Operator.  This window lists all of the possible options for the selected 
filter (Operator) and how many data points exist in the data set for each of the options.  In Figure 
3, there are 287 data link messages for AAL, 483 data points for AAR, and so on. Initially all 
options are selected.   

4.4. By default, the filter pop-up window displays the options sorted by name in alphabetical 
order.  By pressing the “Sort by Count” button (located on the bottom right side of the window), 
the options can be sorted in descending order of the number of data points associated with each 
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option.  The “Select All” and “Deselect All” buttons provide the named functionality which is 
available to aid in the selection of few or many of the available options.  To return to the default, 
press the “Sort by Name” button.   

 

Figure 2 
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Figure 3 

5. Second-Level Filtering 

5.1. Once the first-level filter has been applied, a second-level filter may be chosen.  Second-
level filtering is available under “Type of Analysis to Perform,” which can be found in the 
“Options” pull-down menu.  Figure 5 illustrates the pop-up window produced by selecting “Type 
of Analysis to Perform.” 

5.2. The default setting for this filter is the “All Data” option, which applies no second-level 
filtering.  If second-level filtering is required, the following are the available options: 

 Month 
 FIR 
 Media type 
 GES 
 Operator 
 Aircraft Type 
 Airframe 
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Figure 1 

 
Figure 5 

5.3. If one of the second-level filtering options listed in the “Type of Analysis to Perform” 
window is selected, the options corresponding to that selection with the first-level filter applied 
are displayed.  For the example shown in Figure 6, the first-level filter selected was Operator 
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ABC. When the “Aircraft Type” analysis was selected, only the available aircraft types for 
Operator ABC were displayed, i.e. A332 and A388. 

5.4. In Figure 6, the numbers within parentheses to the right of the aircraft type provide the 
number of messages to be included in the chart based on the selected first level filter.  The 
number on the right represents the total number of data points for this category in all of the input 
data.  The number of the left represents the number of data points available for this category after 
the first level filter has been applied.  Thus, in Figure 6, it is shown that there are a total of 901 
data points corresponding to an A332 aircraft in the input data and 133 of these belong to the 
Operator ABC. 

5.5. The aircraft types contained in the input data file that are not available for Operator ABC 
are also shown in the window in Figure 6, but these options are shadowed as they are not 
available for this selection based on the first-level filter. 

5.6. Only one option may be selected for the “Type of Analysis.” However, once the option 
for the “Type of Analysis” has been selected, multiple options may be selected within the 
second-level filter (such as multiple aircraft types).   

 
Figure 6 

6. Selection of Performance Parameter and Criteria 

6.1. For CPDLC analysis, the G-PAT can create the ACP, ACTP and PORT charts.  The 
options for the type of chart to be created can be found by selecting “Performance Parameter” 
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from the “Options” pull-down menu of the toolbar shown in Figure 7.  The pop-up window 
generated by selecting “Performance Parameter” is shown in Figure 8.   

 

 
Figure 2 

 

 
Figure 8 

6.2. There are no “Performance Parameter” options to select for the ADS-C data.  The only 
chart prescribed for ADS-C analysis in the GOLD is the ADS-C Downlink Latency chart so this 
is the only chart generated by G-PAT for ADS-C data. 

6.3. The options for performance criteria, e.g. the 95 and 99.9 percent performance goals to be 
used in the chart, can be found by selecting “Performance Criteria” from the “Options” pull-
down menu of the Toolbar shown in Figure 9.  The pop-up window generated by selecting 
“Performance Criteria” is shown in Figure 10. As shown in Figure 10, the default performance 
criteria are initially checked based on the selected “Performance Parameter.”      
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Figure 3 

 
Figure 10 

 

7. Generation of The Output Chart And Report 
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Figure 4 

7.1. Once the input data has been loaded, the first and second-level filters have been applied, 
and the performance parameter and criteria have been selected, the G-PAT is ready to produce 
the GOLD chart and report. The chart and report corresponding to the current selections are 
visible by selecting the appropriate tab at the bottom of the G-PAT window (circled in red in 
Figure 11). 

7.2. To create the GOLD chart and report for the existing selections in a new Tab, click the 
“Create Chart” button.  To create a new chart in the current Tab, overwriting the currently-
displayed chart and report, click the “Refresh Chart” button. 

7.3. Figure 12 shows a sample chart and report for the observed performance of CPDLC 
message transactions from the A380 and B744 aircraft types for Operator QFA using the default 
performance criteria (RCP240/RSP180). 
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Figure 5 
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8. Modification of The Chart 

8.1. Once a GOLD chart has been generated, the properties of the chart can be changed to 
modify the view. 

8.2. The default view is a scale from 90 to 100 percent on the vertical range (y) axis, with 
increments of 1 percent.  To change the view to a scale from 0 to 100 percent on the vertical 
range axis, right-click and select “Auto Range.” To return to the default setting, press the 
“Refresh Chart” button.  

8.3. To zoom on a particular portion of the chart, click and drag the mouse to draw a box 
enclosing the desired area.  This area will then be enlarged to fit the screen.   

8.4. Several other chart properties are accessible by right-clicking on the chart and selecting 
“Properties.”  This action will open the “Chart Properties” window, which contains the three tabs 
shown in Figure 13: “Title”, “Plot”, and “Other.” 

 

 
Figure 13 

 



  ISPACG/26 FIT/19 
  WP-03, Attachment A 
  Page A-20 of A-23 
   

FIT19 WP-03 GOLD Performance Analysis Tool Status.Doc 

8.5. The “Title” tab, shown in Figure 13, allows properties of the chart title to be modified. 
The chart title can be hidden by deselecting the check box displayed to the right of the chart title 
text box. The text of the title can be changed in addition to the font, size, and color of the title. 

 

 

 
Figure 14 

 

8.6. The “Plot” tab allows properties of the horizontal domain (x) axis and of the vertical 
range (y) axis to be independently modified.  As shown in Figure 14, the label as well as its font, 
size, and color can be changed.  Additional properties, such as the showing or hiding of the tick 
labels and tick marks for the axes, can be modified. 

8.7. The range displayed on the chart can be modified by selecting the “Range” tab, shown in 
Figure 15.  To adjust the range, deselect the checkbox for “Auto-adjust range” and then enter the 
desired minimum and maximum range values. 
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Figure 15 

 

4  
Figure 16 
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8.8. The remaining tab, “Other”, shown in Figure 16, allows the line colors in the chart to be 
modified.  

9. Save or Print a Copy of the Chart or Report 

9.1. The generated chart or report can be saved using the “File” pull-down menu of the 
toolbar.  Alternatively, “Save Chart” and “save report” buttons are available below the toolbar.  
Note that when saving the report, a valid file extension must be added to the end of the file name. 

9.2. When saving the chart using the file pull-down menu or the “Save Chart” button, the 
chart will be saved as a jpg file.  To save the chart as a png file, simply right-click the chart and 
select “Save As.” 

5  

 

Figure 6 
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Attachment B. Sample CPDLC Transaction Data for use in G-PAT 

 
ATSP,REGNO,ACTYPE,OPER,DATE,MASRGS,OPRGS,UTIME,MASTIME,MASRTRP,FMSTIME,ATSPTIME,OPRTRIP,DTIME,UMSG,DMSG,ACTP,ACP,PORT,COMTYP 

KZAK,9VSGB,A345,SIA,20101201,POR1,POR1,08:07:05,08:07:09,4,08:07:17,08:07:23,18,6,U30,DM0,18.0,8.0,10.0,SAT 

KZAK,9VSGB,A345,SIA,20101201,POR1,POR1,09:47:38,09:47:42,4,09:47:57,09:48:04,26,7,U20,DM0,26.0,9.0,17.0,SAT 

KZAK,9VSGB,A345,SIA,20101201,POR1,POR1,10:57:23,10:57:29,6,10:57:32,10:57:47,24,15,U82,DM0,24.0,18.0,6.0,SAT 

KZAK,9VSGB,A345,SIA,20101201,POR1,POR1,12:55:12,12:55:18,6,12:55:28,12:55:51,39,23,U20,DM0,39.0,26.0,13.0,SAT 

KZAK,B16412,B744,EVA,20101201,POR1,POR1,21:14:33,21:14:39,6,21:14:51,21:15:00,27,9,U31,DM0,27.0,12.0,15.0,SAT 

KZAK,B16412,B744,EVA,20101201,POR1,POR1,21:41:55,21:42:02,7,21:42:10,21:42:20,25,10,U20,DM0,25.0,13.5,11.5,SAT 

KZAK,B16483,B744,EVA,20101201,POR1,POR1,09:54:36,09:54:43,7,09:54:49,09:54:59,23,10,U20,DM0,23.0,13.5,9.5,SAT 

KZAK,B16483,B744,EVA,20101201,POR1,POR1,12:53:38,12:53:45,7,12:53:53,12:54:24,46,31,U20,DM0,46.0,34.5,11.5,SAT 

KZAK,B16701,B77W,EVA,20101201,POR1,POR1,08:44:19,08:44:29,10,08:44:32,08:44:48,29,16,U20,DM0,29.0,21.0,8.0,SAT 

KZAK,B16701,B77W,EVA,20101201,POR1,POR1,09:19:53,09:20:04,11,09:20:08,09:20:24,31,16,U20,DM0,31.0,21.5,9.5,SAT 

KZAK,B16701,B77W,EVA,20101201,POR1,POR1,09:52:55,09:53:05,10,09:53:15,09:53:28,33,13,U26,DM0,33.0,18.0,15.0,SAT 

KZAK,B16707,B77W,EVA,20101201,POR1,POR1,21:51:06,21:51:16,10,21:51:38,21:51:52,46,14,U23,DM0,46.0,19.0,27.0,SAT 

KZAK,B16707,B77W,EVA,20101201,POR1,POR1,22:03:49,22:03:59,10,22:04:00,22:04:17,28,17,U23,DM0,28.0,22.0,6.0,SAT 
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Attachment C. SampleADS-CTransactionDataforuseinG-PAT 

 
ATSP,REGNO,ACTYPE,OPER,DATE,RGS,TYP,LAT,LONG,STIME,RTIME,DEL,COMTYP 

KZAK,N851FD,B77L,FDX,20101130,POR1,ADS,+51.9845581054688,-149.733180999756,23:59:48,00:00:01,13,SAT 

KZAK,N69063,B764,COA,20101201,XXC,ADS,+34.5065116882324,-133.064002990723,00:00:41,00:00:59,18,SAT 

KZAK,N220UA,B772,UAL,20101201,XXC,ADS,+25.242805480957,-171.414184570312,00:01:25,00:01:34,10,SAT 

KZAK,N220UA,B772,UAL,20101201,XXC,ADS,+25.2455520629883,-171.426200866699,00:01:30,00:01:43,13,SAT 

KZAK,B16713,B77W,EVA,20101201,POR1,ADS,+44.0457344055176,-144.599475860596,00:01:31,00:01:48,17,SAT 

KZAK,JA603J,B763,JAZ,20101201,HNL,ADS,+21.0994148254395,-158.212738037109,00:01:52,00:01:56,4,VHF 

KZAK,N213UA,B772,UAL,20101201,KOA,ADS,+21.4827346801758,-155.467529296875,00:02:10,00:02:14,5,VHF 

KZAK,JA743J,B77W,JAL,20101201,POR1,ADS,+45.9980392456055,-150.003547668457,00:02:09,00:02:16,7,SAT 

KZAK,BHUG,B744,CPA,20101201,XXC,ADS,+47.0384788513184,-179.028568267822,00:02:12,00:02:32,20,SAT 

KZAK,N76065,B764,CMI,20101201,XXC,ADS,+15.1077461242676,+170.891647338867,00:02:16,00:02:35,19,SAT 

KZAK,9VSPO,B744,SIA,20101201,POR1,ADS,+48.2315254211426,-130.203266143799,00:02:14,00:02:41,27,SAT 

KZAK,BKPQ,B77W,CPA,20101201,XXC,ADS,+46.0011291503906,-159.993209838867,00:02:48,00:03:05,17,SAT 

KZAK,N599FE,MD11,FDX,20101201,MKK,ADS,+24.048900604248,-156.320686340332,00:03:10,00:03:16,6,VHF 

KZAK,JA615A,B763,ANA,20101201,POR1,ADS,+27.0016479492188,+179.997940063477,00:03:22,00:03:37,15,SAT 

 

 

-END- 
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